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Top Issues:  Adobe PageMaker 6.0 for Windows

This document summarizes the most common issues that we're hearing in Adobe Technical Support 
about Adobe PageMaker 6.0 for Windows. Document numbers are included for those issues with more 
detailed information, which are available on the Adobe BBS at 206-623-6984 in the PageMaker 
conference, on the Adobe home page on the World Wide Web (http://www.adobe.com/), and on our 
automated faxing system Adobe FaxYI, available 24 hours a day, 7 days a week, at 206-628-5737.

This document was last revised December 14, 1995. Issues that are new or updated from the previous 
revision are indicated with an asterisk (*).

1. Installation Tips
Before installing PageMaker, refer to the "ReadMe" file located in the Utilities Folder on Disk 1 of 
the PageMaker installation disk set or in the Install folder in the Adobe PageMaker 6.0 folder on 
the CD-ROM. This file includes important late-breaking information that is not available in 
manuals or online documentation. Refer to the Adobe PageMaker 6.0 Getting Started guide for 
installation information and minimum system requirements.

Serial numbers
- Valid serial numbers include those with the prefix "03W" (PageMaker 6.0) and "03" 

(PageMaker 5.0x and earlier).
- Adobe Acrobat Distiller PE, included on the PageMaker 6.0 CD-ROM, requires a serial 

number during installation. Use the Distiller serial number located on the registration card 
included with your PageMaker 6.0 package.

- Adobe Photoshop LE, included on the PageMaker 6.0 CD-ROM, requires a serial number 
during installation. Use the Photoshop serial number located on the registration card included 
with your PageMaker 6.0 package.

Language Choices in the Installer/Utility
When you launch the PageMaker 6.0 Installer/Utility, you have three language options:  U.S. 
English, Canadian English, and International English. Choose the language you want the 
PageMaker 6.0 Installer and the PageMaker 6.0 application to use. This selection affects the 
spelling of certain words, such as "color" and "colour," in dialog boxes. Later, in the "PageMaker 
Dictionaries" dialog box, choose which spelling and hyphenation dictionaries you want to install. 
You may choose any or all of the listed dictionaries, regardless of the choice of language you 
made in the first screen of the installer.

For more information, request document number 316401.

For information on Network installations of PageMaker 6.0, request document number 316402.

2. Unable to Install PageMaker 6.0 from CD-ROM
When unable to install PageMaker 6.0 from the CD-ROM, do one or more of the following:
A. Examine the CD-ROM for dirt, dust, or fingerprints. Wipe the bottom of the CD-ROM gently, 

from the center outward, with a soft, lint-free cloth. Examine the CD caddy or loading tray for 
your CD-ROM drive. If it is dirty, wipe it with a clean, lint-free cloth. Make sure the inside of 
the Adobe PageMaker 6.0 Deluxe CD-ROM envelope is clean. 

B. When running Windows 3.1, create a boot floppy to ensure no other device drives or RAM 

Top Issues:  Adobe PageMaker 6.0 for Windows    Adobe Systems Inc. 1



resident utilities are interfering with the installer or Windows. For information on creating a 
bootable floppy disk, request or download FaxYI document number 300410.

When running Windows 95, boot your computer in Safe Mode. To start Windows in Save 
Mode, hold the F8 key after the Starting Windows 95 message appears during startup, then 
choose Save Mode in the Windows 95 Startup menu.

C. Install PageMaker 6.0 from the PageMaker 6.0 Installation disks, instead of the Adobe 
PageMaker 6.0 Deluxe CD-ROM.

When installing an application from a CD-ROM that is dirty, the installer is unable to read the 
data on the media and returns read errors.

*3. Installing PageMaker 6.0 for Windows from CD-ROM Prompts for Disk 5
When installing PageMaker 6.0 from CD-ROM on Windows 3.1x, the installer returns the prompt 
"Please insert Disk 5" when installing the "days.tx_" file, but the "days.tx_" file is not located on 
Disk 5, preventing the installation from continuing. 

To prevent the prompt to insert Disk 5 when installing from the PageMaker 6.0 CD-ROM, do one 
or more of the following:
A. Install PageMaker 6.0 by choosing Minimum install or Custom install with PageMaker 6.0 

deselected. If desired, choose to install the PageMaker 6.0 templates by choosing Custom 
install after installing PageMaker 6.0.

B. Install by locating the PageMaker 6.0 directory (i.e., PM6) into the root directory (e.g., C:\).

Adobe Technical Support is researching this issue, and will update this document when the cause 
and additional solutions are known. 

4. Troubleshooting Win32s Errors and Installation Problems
When running Adobe PageMaker 6.0, Windows returns a "Win32s error," an "Application Error," 
or an "Unexpected DOS Error -21."

For instructions on troubleshooting Win32s errors, request document number 316405.

For instructions on removing and reinstalling Win32s components for PageMaker 6.0, request 
document number 316404.

*5. "Assertion Failed.R" Error when launching Adobe Table 2.5
When launching Adobe Table 2.5 running in Windows 95, the error "Assertion Failed.R" occurs.

To prevents the error "Assertion Failed.R" when launching Adobe Table 2.5 running in Windows 
95, do one or more of the following:
A. Update to Adobe Table 2.5.1, which includes only the change that prevents the "Assertion 

Failed.R" error when launching. To obtain the Adobe Table 2.51 update, contact Adobe 
Technical Support at (206) 628-4531

B. Reduce the size of the WIN.INI file to 64K or less.

C. Install fewer than 150 PostScript Type 1 and TrueType fonts.

D. When TrueType fonts were installed using a third-party font management utility (e.g., 
FontMaster 6.0 included with CorelDRAW 6.0), remove then reinstall TrueType fonts using 
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the Windows 95 Fonts Control Panel.

E. Verify that installed fonts are compatible with Windows 95.

F. When using Adobe Type Manager (ATM), rename the ATMFONTS.QLC file then restart 
Windows.

G. Remove duplicate fonts loaded in multiple font utilities. For example, when the font Helvetica 
is installed in both the Windows 95 Fonts Control Panel and in ATM, remove Helvetica from 
either the Windows 95 Fonts Control Panel or ATM.

H. Ensure your computer system meets the minimum requirements to run PageMaker 6.0 in 
Windows 95. PageMaker's requirements for Windows 95 are listed on page 1 of the 
PageMaker 6.0 Getting Started manual.

I. When only using TrueType fonts, temporarily turn off ATM to increase the memory available 
to your operating. When ATM is turned off, Type 1 fonts do not display or print.

*6. Error "PROGMAN.EXE Caused a GPF in WINMM16.DLL" Printing from PageMaker

When printing from PageMaker 5.0x or 6.0 when running Win32s in Windows 3.x, the system 
returns the error "PROGMAN.EXE caused a General Protection Fault in module WINMM16.DLL 
at 0001:0296.", where the memory address "0001:1296" may vary. The publication prints as 
expected, but Program Manager closes, forcing the system to exit Windows 3.1x or Windows for 
Workgroups.

To prevent the PROGMAN.EXE caused a General Protection Fault error when printing from 
PageMaker:
Remove the reference to the WINMM16.DLL file in the [Boot] section of the SYSTEM.INI file:

1. Make a backup copy of the SYSTEM.INI file.
2. Open the original SYSTEM.INI file, located in the WINDOWS directory, in a text editor 

that can save in text-only format (e.g., WordPad, Notepad).
3. Locate the line that read:

drivers=mmsystem.dll winmm16.dll

4. Edit the line to read:

drivers=mmsystem.dll

NOTE:  Remove only the winmm16.dll reference, not the entire line, which may be 
required by other applications.

5. Save in text-only format then restart Windows.

OR:  Choose another video driver (e.g., VGA).

WINMM16.DLL is a Windows 32-bit system file installed by Win32s applications, enabling access 
to 16-bit multimedia functions. PageMaker does not use the WINMM16.DLL file.

Adobe Technical Support is researching this issue, and will update this document when the cause 
and additional solutions are known. 

*7. Unable to use Acquire Image in PageMaker 6.0 for Windows
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After selecting File  > Acquire > Acquire Image, nothing happens, an error occurs, or the 
scanning software launches successfully, but after scanning the PageMaker cursor does not 
return.

Do one or more of the following:
A. Installed the following files in the specified location, which Acquire Image requires:

Plugins directory
ACQUIRE.ADD (size 200,192 bytes, date 10/1/95)

Windows directory
TWAIN_32.DLL (size 77,824 bytes, date 10/11/95)
TWUNK_16.EXE (size 47,664 bytes, date 10/19/95)
TWUNK_32.EXE (size 68,608 bytes, date 10/19/95)
TWAIN.DLL (size  85,696 bytes, date 9/11/95) 

NOTE:  The TWAIN.DLL file has been updated since PageMaker 6.0 was released. The 
updated TWAIN.DLL file is available on the Adobe BBS, where it is named TWAIN.ZIP 
and located in the PM6 library file.

 
Windows/TWAIN directory

.DS file (when working with 16-bit Data Source)
Windows/TWAIN_32 directory

.DS file (when working with 32-bit Data Source)

B. When unable to locate your scanner's .DS file, refer to your scanner software manufacturer 
to obtain the .DS file for your scanner.

C. Scan from the scanning software instead of from within PageMaker using the Acquire Image 
command.

D. Close PageMaker, delete or rename the PM6.CNF and PM6FLT.CNF files from the PM6 
directory, then relaunch PageMaker. PageMaker recreates the PM6.CNF and PM6FLT.CNF 
files when these files are unavailable when PageMaker is launching.

F. Ensure the scanner supports TWAIN, and when running Windows 95, is Windows 95 
compatible, by contacting your scanner's manufacturer.

G. Ensure the scanner is turned on and ready. Some devices may need to be turned on before 
the CPU startup to initialize through the interface card.

H. Ensure there is sufficient hard disk space available. A 300 sample per inch 24-bit color 8" x 
10" TIFF image requires approximately 21 MB of hard disk space. Scanning at an 
appropriate resolution for the file type, dimension, and output requirements of the final printer 
ensures the TIFF image's file size is no larger than necessary.

PageMaker 6.0 uses a different TWAIN DLL file (i.e., TWAIN_32.DLL) than PageMaker 5.0 and 
Adobe Photoshop, and accesses TWUNK files that are not currently in use by other applications.

The PM6.CNF and PM6FLT.CNF files contain PageMaker's default application and filter 
configurations.

8. Troubleshooting ODBC Problems 
Adobe PageMaker 6.0 includes an Open Database Connectivity (ODBC) filter and ODBC plug-in, 
which enable you to import data from database applications when using PageMaker in Windows 
95. Using the ODBC filter, PageMaker can place flat database files (i.e., files that contain all the 
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information in one database). Using the ODBC plug-in, PageMaker can place flat database files 
or relational database files (i.e., files that contain information in more than one database or table) 
using Standard Query Language (SQL) commands. The ODBC filter and ODBC plug-in are not 
supported in PageMaker using Win32s.

When the ODBC filter and ODBC plug-in are both installed, PageMaker uses the ODBC plug-in 
and not the ODBC filter that appears in PageMaker's list of installed filters. 

To verify that a filter has been installed, hold down the control key and choose Help > About 
PageMaker to view a list of installed components. When a filter does not appear in the list of 
installed components, you can install the filter using the Single File Copy command in the 
PageMaker 6 Installer Utility.

To install ODBC DLLs, see page 5 of the Adobe PageMaker 6.0 Getting Started guide. 

For additional information on the ODBC Filter or Plug-in, request document number 316403.

9. Metafiles Print Smaller or Partially Print from PageMaker Running on Windows 95
When printing from PageMaker 5.0 or later on Windows 95, Enhanced Metafile (EMF) or 
Windows Metafile (WMF) graphics partially print or print smaller than expected. 

To enable PageMaker to print EMF and WMF graphics as expected:
Install a printer that supports a higher resolution from the Windows 95 CD-ROM or installation 
disk set.

OR:  When your printer is not included on the Windows 95 CD-ROM, install a printer using the 
PM6PRINT.INF file, included on the Adobe PageMaker 6.0 Deluxe CD-ROM or installation disk 
set:

1. Make sure the PM6PRINT.INF file and the PPD file for your printer are located in the 
PM6\RSRC\[language]\PPD4 folder.

2. Install your printer using the Windows 95 Add Printer Wizard until you see the Have Disk 
option.

3. Click Have Disk.
4. In the Install From Disk dialog box, type the path to the PPD4 folder (e.g., 

"C:\PM6\RSRC\USENGLSH\PPD4") or click Browse to navigate to the PPD4 folder. 
5. Select the PM6PRINT.INF file, then click OK."
6. Follow the on-screen instructions, inserting the Windows 95 CD-ROM or installation disks 

when prompted.
7. When installation is complete, the new printer lists in your Printers folder.

OR:  Reimport the graphic saved in a different format (e.g., EPS, TIFF, BMP).

For more information, request document number 316101.

10. Error "Unable to load icon DLL's for this screen. 7527:6622" Launching PageMaker 6.0 in 
Windows 95
The error "Cannot start PageMaker, unable to load icon DLL's for this screen. 7527:6622" occurs 
when launching PageMaker 5.0x or later running in Windows 95.

The message "Cannot install <font name> font. The file may be damaged. Check with your font 
vendor to obtain a new file" appears during font installation or while dragging a font into the Fonts 
folder. Unexpected fonts appear in title bars or on the desktop. The Fonts folder gives 
inconsistent information about how many or which fonts are installed.
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To prevent the "Unable to load icon DLL's for this screen. 7527:6622" error when launching 
PageMaker:
Reduce the number of TrueType fonts in the Fonts folder.

OR:  When using a font utility other than the Windows 95 Fonts Control Panel (e.g., FontMaster 
6.0, included with CorelDRAW 6.0), remove fonts installed through the font management utility, 
then reinstall them using the Fonts control panel:

1. Open the Fonts folder by clicking the Start icon on the Taskbar, then choosing Settings > 
Control Panels > Fonts.

2. Select the TrueType fonts in the Fonts Control Panel.
3. Choose Edit > Delete or drag the fonts out of the Fonts folder.

OR:  Remove TrueType fonts using the deinstallation functions of your font installation 
utility. For instructions, refer to the utility's documentation. 

NOTE:  Do not remove Windows 95 standard fonts, which are required by Windows 95 
and other applications.

4. In the Fonts folder, choose File > Install New Font.
5. In the Add Fonts dialog box, select the directory or drive that contains the font files, 

select the fonts you wish to install, then click OK.

For more information, request document number 316302.

11. Cross-Platform Transfer of PageMaker 5.0x and Later Publications
Adobe PageMaker uses the same file format for publications created on a Macintosh or 
IBM-compatible computer, allowing easy transfer of PageMaker publications between platforms. 
When transferring PageMaker publications, the PageMaker application must be the same major 
version on the Macintosh and IBM-compatible computer.

For example, a publication created in PageMaker 5.0x for Windows can be opened by 
PageMaker 5.0x for the Macintosh, but not by PageMaker 6.0 for the Macintosh. To open a 
PageMaker 5.0 for Windows publication in PageMaker 6.0 for the Macintosh, either transfer the 
PageMaker 5.0x for Windows publication to PageMaker 5.0x for the Macintosh then convert it to 
PageMaker 6.0 for the Macintosh, or convert the PageMaker 5.0x for Windows publication to 
PageMaker 6.0 for Windows then transfer it to PageMaker 6.0 for the Macintosh.

To transfer files between an IBM-compatible and Macintosh computer, either connect the two 
computers and use communications software to transfer the files, or use a diskette drive 
specifically designed, or adapted, for this purpose. The IBM-compatible and the Macintosh 
computer can be connected directly using a network, a null modem cable, or a modem at each 
computer, with or without a phone connection. Macintosh System 7.1 and later includes a utility 
called PC Exchange, which can read from and write to IBM-compatible disks. 

For more information, request document number 116313.

12. PageMaker 6.0 Features Not Supported When running Windows 3.1 and Win32s
Adobe PageMaker 6.0 includes features that require a 32-bit operating system (e.g., Windows 
95, Windows NT). PageMaker does not support the following when using a 16-bit operating 
system (e.g., Windows 3.1x, Windows for Workgroups):
- Clipping paths display or printing to non-PostScript printers.
- Masked objects printing to non-PostScript printers.
- Adobe Table 2.5 on Windows 3.1. PageMaker 6.0 installs Adobe Table Editor 2.11 when 

installing on Windows 3.1.
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- All network installation options. The only network installation option available when installing 
PageMaker 6.0 on Windows 3.1 is installing PageMaker 6.0 disk images to a network server.

- Importing EMF (Enhanced Metafile) graphics when running Win32s. PageMaker does not list 
EMF files in the Place Document dialog box.

- Gallery Effects when running Win32s.

For more information, request document number 316406.

13. "Error... WINSPOOL.DRV" Installing Win32s or Launching PageMaker 6.0
When installing Win32s, the error "Error writing WINSPOOL.DRV." occurs, preventing 
installation.

When launching Adobe PageMaker 6.0 in Windows 3.1, the error "Win32s - Error: Error while 
reading c:\windows\system\win32s\winspool.drv." appears and PageMaker does not launch.

To prevent the Win32s error when installing Win32s or launching PageMaker 6.0:
Disable LaserMaster's WinPrint Manager 1.x:

1. Make a backup copy of the SYSTEM.INI file, located in the WINDOWS directory.
2. Open the SYSTEM.INI file in a text editor that saves as text-only (e.g., Windows Write, 

Notepad).
3. Find the following entries in the [386Enh] section of the SYSTEM.INI. file:

device=LMHAROLD.386;[xxx]
device=LMCAP.386;[xxx]
device=LMMI.386;[xxx]

where [xxx] is the name of the printing device being used.
4. Insert a semicolon before the word "device" in each line. For example:

;device=LMHAROLD.386;[xxx]
;device=LMCAP.386;[xxx]
;device=LMMI.386;[xxx]

5. Save the SYSTEM.INI file as text only, then exit and restart Windows.

OR:  Disable WinPrint Manager by running LaserMaster's deinstallation utility. For more 
information, see your LaserMaster documentation.

NOTE:  Disabling WinPrint Manager disables LaserMaster Postscript emulation.
 
OR:  Install PageMaker 6.0 through Windows 95, then install the LaserMaster Windows 95 
software for your printer. For information on updating LaserMaster printing software, contact 
LaserMaster.

LaserMaster's WinPrint Manager 1.x is incompatible with Microsoft Win32s. 

For more information on LaserMaster printers and Win32s, request document number 316407.

For more information on LaserMaster printers and Windows 95, request document number 
316102.

14. Error "You have printer and display fonts that are mismatched" When Printing from 
PageMaker 6.0
When printing to a PostScript printer, Adobe PageMaker 6.0 returns the error "You have printer 
and display fonts that are mismatched. Text may not print as expected. To correct this, refer to 
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the 'Readme.wri.'" after the first page has been printed. 

After clicking Continue in the error dialog box, the error does not reappear, and text does not 
print as expected (e.g., text appears smudged, kern pairs vary with printer resolution, fonts are 
substituted, line endings change). After clicking Cancel in the error dialog box, the rest of the 
print job is canceled.

To prevent the error "You have printer and display fonts that are mismatched. Text may not print 
as expected. To correct this, refer to the 'Readme.wri.'" when printing from PageMaker 6.0:
Reinstall your PostScript fonts using Adobe Type Manager (ATM) then restart Windows 95:

1. Launch the ATM control panel by clicking Start in the Taskbar then choosing Programs > 
Main > ATM Control Panel.

2. Select all fonts in the Installed ATM Fonts window and click Remove.
3. Click Add.
4. In the Add ATM Fonts dialog box, select the directory where your font metric files (i.e., 

*.PFM) are located (e.g., C:\PSFONTS\PFM).
5. From the left side of the dialog box, select the fonts you want to reinstall, then click Add.

NOTE:  Add no more than 50 fonts at a time. The Application Programming Interface 
(API) call that ATM makes to add fonts to the WIN.INI file supports only 24K of data.

6. Restart Windows 95. 

OR:  Remove multiple [PostScript, <port>] sections in your WIN.INI file, then reinstall your 
PostScript fonts. 

For more information, request document number 316103.

*15. Cannot Install PageMaker 6.0 on Computer Using NexGen 586 Processor
When installing Adobe PageMaker 6.0 on a computer using a NexGen Nx586 processor, the 
Adobe PageMaker 6.0 Installer (SETUP.EXE) returns the error "Unable to install Adobe 
PageMaker 6.0. Minimum configuration requires a 486 processor or greater."

To install PageMaker 6.0 on a computer using a NexGen Nx586 processor:
Install the UPDTVI20.EXE update (NexGen Nx586 VL processor) or the UPDTPI10.EXE update 
(NexGen Nx586 PCI processor) from NexGen. 

Because Adobe PageMaker 6.0 requires a 486 or later processor, the PageMaker 6.0 Installer 
queries the computer to determine computer's processor. When queried by the PageMaker 6.0 
Installer, the NextGen Nx586 processor returns unexpected information, preventing the installer 
from completing the installation and causing the error "Unable to install Adobe PageMaker 6.0. 
Minimum configuration requires a 486 processor or greater."

NexGen can be reached at:
Technical Support:  800-863-9436
BBS:  408-955-1839
tech.support@nexgen.com

Revision 4.0
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